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ZAR8 - Software for Ravigneaux Gears
A Ravigneaux gear contains two planetary gear stages: one (minus) planetary gear set and one plus
planetary gear set with planet gear pairs instead of planet gears. Carrier as well as ring gear of both
planetary gear sets are connected or common. And planet wheel of the minus planetary set is used
as outer planet wheel of the plus planetary gear set.

Five gear wheels in two planetary gear sets: Si (small sun wheel), Pi (inner planet wheel), Pe (outer
planet wheel), H (hollow wheel), Se (large sun wheel) are calculated by ZAR8 in one pass.



ZAR8  Ravigneaux Gear Software
In pre-dimension, you can enter transmission ratio of first gear and fourth gear. The transmission of
the other gears 2, 3 and R are directly calculated and displayed, also the gear step between gear
1,2,3,4. Transmission ratio i0i of plus planetary gear set is transmission ratio of the 1st gear, and
transmission ratio of the minus planetary gear set i0e is transmission ratio of the rear gear.
Next enter power or input torque and input speed. You can define number of teeth of the ring gear
zH, and ZAR8 calculates dimensions of all gear wheels under consideration of  assembly conditions
for planetary gear sets.

In the next input window you can modify dimensions such as profile shift coefficients, tooth tip
reduction, face width of the gear wheels.



ZAR8  Ravigneaux Gear Software
Four connector shafts Si, C, H, Se can be defined as driving (in), driven (out), control or idle. By
means of the buttons 1,2,3,4,R you can shift the standard gears of the Ravigneaux gear.

In an animation you can rotate the gear wheels of the Ravigneaux gear set on the computer screen.

To calculate load bearing capacity for each of the five gear wheels and four tooth contacts (Si-Pi,
Pi-Pe, Pe-H, Se-Pe), select gear materials from integrated database and input additional data for
strength calculation according to ISO 6336 or DIN 3990.

ZAR8 is available now for 1950 EUR.



ZAR7 Software for Plus Planetary Gears (double-planet gears)

A Ravigneaux gear is composed of one simple (minus) planetary gear stage and one plus planetary
gear set. A minus planetary gear set can be calculated by means of ZAR5. For calculation of a plus
planetary gear set, we have made a new software ZAR7. The carrier of a plus planetary gear carries
planet gear pairs instead of single planets as in ZAR5. Planet wheel pairs may be on one axis to the
center of the sun gear, but usually are offset mounted. This allows larger number of teeth and free
definable profile shift coefficients. For number of teeth of ring gear (zH) and sun wheel (zS),
assembly condition for plus planetary gears must be considered:
 (|zH| - zS) / q = f
f  must be integer. q is the number of planet pairs.

Dimensions and load capacity of the four gear wheels S (sun), Pi (inner planet), Pe (outer planet)
and H (hollow gear) calculates ZAR7 in one pass. Additionally, you can select roller bearings for
inner planets and outer planets and calculate in ZAR7.
ZAR7 is available now for 1380 EUR.

Planetary Gear Package
Our new planetary gear package contains the programs for design and calculation of planetary gears
ZAR5, ZAR7, ZAR8, GR1, and also ZAR1+ for a price of 3600 Euros. If upgrade from  ZAR1+ or
ZAR5 or spur gear package, old licenses are credited 75%.



GR1 - Gear Construction Kit Software

By means of GR1 you can "build" multistage gears composed of simple gear pairs, planetary gear
sets, Ravigneaux gear sets, Simpson gear sets and plus planetary gear sets. For each gear stage
element you can define if it is driving (in), driven (out), blocked or idle. For driving elements (i9)
you can enter input speed or select a predecessor gear element.

GR1 calculates speed and transmission ratio of all gear elements.
GR1 does not calculate power, torque nor dimensions.
GR1 is available now for 185 Euros.



FED1+,2+,3+,5,6,7,8: Hot-Coiled Springs: 2E6 Load Cycles

Cold-coiled springs are fatigue strength safe if enduring more than ten million load cycles. In the
spring calculation software, this was treated equal for hot-coiled springs until now. But Goodman
diagrams in EN 13906-1 for hot-coiled springs are drawn for 2E6 load cycles (fatigue strength safe)
and for 1E5 load cycles. The EN 13906 Goodman diagram for hot-coiled springs shows curves for
bar diameters of d=10mm, 15mm, 25mm, 35mm and 50mm. These diagrams with fatigue strength
safety for 2E6 instead of 1E7 load cycles (for hot-coiled springs only) are used now in our software
for compression springs, extension springs, torsion springs and torsion bars. However, at "Edit-
>Calculation Method" you can configure the calculation as used until now with fatigue strength
safety at 10 million load cycles for all spring materials.

Goodman diagrams for hot-coiled springs are valid for spring materials to EN10089 with ground or
shaved surface. At "Edit->Production" you must set "hot-coiled, steel with reworked surface" and at
"Edit->Material->Surface" "ground" or "shaved". For hot-rolled spring steel with drawn or rolled
surface is no Goodman diagram available. Instead of 3 curves for 10 million, 1 million and 100,000
load cycles, new Goodman diagram for hot-rolled springs shows only 2 curves: for 2 million cycles
and 100,000 cycles.



FED1+, 2+,3+,5, FED6, 7,9: Spring drawings in command line mode
Drawings created in command line mode (i.e. wfed1 test.fed /CAD1:27 ) were drawings of the
unloaded spring with spring length L0 until now. This has been changed, spring drawings are
created in the defined spring length now. This enables you to automate spring drawings as DXF or
IGES file in various spring lengths.

FED1+: Quick Input Window: Assembly length L for spring drawings
If you selected spring drawings (front view,  section drawing, 3D), you can input assembly length L
next to "Display" field now.

In FED1+, indices for drawings and diagrams used in command line mode are now equal with
indices in Quick Input window, this begins with index 1 = "Quick 1" until Index 35 stress Rm-d
Quick". Index 25, 26, 27 for spring drawings (view, section, 3D centerline). Example command
line: "wfed1 actual.fed /cad1:25"

FED4: SigmaOM
Bending stress SigmaOM of the disk spring is mainly used to calculate static stressed disk springs.
SigmaOM has been added to stress diagrams and printout.

FED4: Load cycles for disk spring materials according to DIN 2093
In FED4 you can decide to use material according to DIN 2093 or from material database.
Calculation of load cycles has been added to disk springs with material data to DIN 2093.



GEO4, ZAR4: New Input Windows Sinus-Linear, Polygon, Eccentric
New input windows were created for cam geometry in GEO4 and for pitch curve of nonlinear gear
in ZAR4 for sine-linear, polygon and eccentric element geometry.

ZAR1+, ZAR5: New Dialogue Window for Strength Calculation Data
Input data for strength calculation to ISO 6336 and DIN 3990 have been integrated into one
common dialogue window.



ZAR1+, ZARXP, ZAR1W, ZAR5: Drawing Options and Ring Gear with Bore Holes
Same as known from WN2, at  CAD->Gear Wheel and STL->Gear Wheel you first get a
dialogue window with settings. New for ring gears is the possibility to define a pitch circle with
bore holes. This is useful if you produce ring gears directly with 3D printer.

SR1/SR1+ : Tightening Torque

Instead of min/max tightening torque MA,max and MA,min, or nueRp and alphaA, you have a new
alternative to input average tightening torque with tolerance in % instead.



Modify Dialogue Window Size and Dialogue Element Size (Text Size)

If text and input fields are too small (i.e. notebook with high graphic resolution but small display)
you can modify dialogue window size and dialogue element size at "File->Settings->Graphics".
Also in Control Panel of Windows you can modify size of text and dialogue elements. These
Windows settings differ in Windows 10, Windows 8, Windows 7.

If you make changes in the Windows settings, you maybe next have to adapt the new settings in the
HEXAGON programs. Or set "Auto" instead of "Input" to adapt Windows settings automatically.
We improved handling with enlarged dialogue windows, input tables were not enlarged in previous
versions. Also we fixed a bug at enlarging database windows. If you configure dialogue element
size, save new configuration, then close and restart program to set new text size also for database
windows. Anyway, if you plan to use HEXAGON software with enlarged dialogue elements and
dialogue windows, we recommend first to update your programs to the latest version.

FED17 - New Software for Magazine Springs
Especially for compression springs with rectangular, oval or elliptic coil shape we can provide a
new software in short.



HEXAGON  PRICELIST  2017-01-01
PRODUCT EUR
DI1 Version 1.2  O-Ring Seal Software 190,-
DXF-Manager Version 9.0 383,-
DXFPLOT V 3.2 123,-
FED1+ V29.3 Helical Compression Springs incl. spring database, animation, relax., 3D,.. 695,-
FED2+ V20.1 Helical Extension Springs incl. spring database, animation, relaxation, ... 675,-
FED3+ V18.8 Helical Torsion Springs incl. prod.drawing, animation, 3D, rectang.wire, ... 480,-
FED4 Version 7.3 Disk Springs 430,-
FED5 Version 15.3 Conical Compression Springs 741,-
FED6 Version 16.0 Nonlinear Cylindrical Compression Springs 634,-
FED7 Version 12.8 Nonlinear Compression Springs 660,-
FED8 Version 6.9 Torsion Bar 317,-
FED9 Version 6.0 Spiral Spring 394,-
FED10 Version 3.3  Leaf Spring (complex) 500,-
FED11 Version 3.3  Spring Lock and Bushing 210,-
FED12 Version 2.4  Elastomere Compression Spring 220,-
FED13 Version 3.9  Wave Spring Washers 185,-
FED14 Version 1.4  Helical Wave Spring 395,-
FED15 Version 1.3  Leaf Spring (simple) 180,-
FED16 Version 1.0  Constant Force Spring 225,-
GEO1+ V6.1 Cross Section Calculation incl. profile database 294.-
GEO2 V2.6 Rotation Bodies 194,-
GEO3 V3.3 Hertzian Pressure 205,-
GEO4 V4.1 Cam Software 265,-
GR1 V1.0 Gear construction kit software 185,-
HPGL-Manager Version 9.0 383,-
LG1 V6.4 Roll-Contact Bearings 296,-
LG2 V2.2 Hydrodynamic Plain Journal Bearings 460,-
SR1 V22.2 Bolted Joint Design 640,-
SR1+ V22.2 Bolted Joint Design incl. Flange calculation 750,-
TOL1 V11.8 Tolerance Analysis 506,-
TOL1CON V1.5 Conversion Program for TOL1 281,-
TOL2 Version 3.3 Tolerance Analysis 495,-
TOLPASS V4.1 Library for ISO tolerances 107,-
TR1 V4.0 Girder Calculation 757,-
WL1+ V19.8 Shaft Calculation incl. Roll-contact Bearings 945,-
WN1 Version 11.6 Cylindrical and Conical Press Fits 485,-
WN2 V 9.6 Involute Splines to DIN 5480 250,-
WN2+ V 9.6 Involute Splines to DIN 5480 and non-standard involute splines 380,-
WN3 V 5.4 Parallel Key Joints to DIN 6885, ANSI B17.1, DIN 6892 245,-
WN4 V 4.5 Involute Splines to ANSI B 92.1 276,-
WN5 V 4.5 Involute Splines to ISO 4156 and ANSI B 92.2 M 255,-
WN6 V 3.0 Polygon Profiles P3G to DIN 32711 180,-
WN7 V 3.0 Polygon Profiles P4C to DIN 32712 175,-
WN8 V 2.2 Serration to DIN 5481 195,-
WN9 V 2.2 Spline Shafts to DIN ISO 14 170,-
WN10 V 4.0 Involute Splines to DIN 5482 260,-
WN11 V 1.3 Woodruff Key Joints 240,-
WNXE V 2.0 Involute Splines - dimensions, graphic, measure 375,-
WNXK V 2.0 Serration Splines - dimensions, graphic, measure 230,-
WST1 V 10.0 Material Database 235,-
ZAR1+ V 25.4 Spur and Helical Gears 1115,-
ZAR2 V7.7 Spiral Bevel Gears to Klingelnberg 792,-
ZAR3 V8.9 Worm Gears 404,-
ZAR4 V5.1 Non-circular Spur Gears 1610,-
ZAR5 V11.1 Planetary Gearings 1355,-
ZAR6 V3.7 Straight/Helical/Spiral Bevel Gears 585,-
ZAR7 V1.0 Plus Planetary Gears 1380,-
ZAR8 V1.0 Ravigneaux Planetary Gears 1950,-
ZARXP V2.1 Involute Profiles - dimensions, graphic, measure 275,-



ZAR1W V1.7 Gear Wheel Dimensions, tolerances, measure 450,-
ZM1.V2.4 Chain Gear Design 326,-

PACKAGES EUR
HEXAGON Mechanical Engineering Package (TOL1, ZAR1+, ZAR2, ZAR3+, ZAR5, ZAR6, WL1+, WN1,
WN2+, WN3, WST1, SR1+, FED1+, FED2+, FED3+, FED4, ZARXP, TOLPASS, LG1, DXFPLOT, GEO1+,
TOL2, GEO2, GEO3, ZM1, WN6, WN7, LG2, FED12, FED13, WN8, WN9, WN11, DI1, FED15, WNXE,
GR1)

8,500.-

HEXAGON Mechanical Engineering Base Package (ZAR1+, ZAR3+, ZAR5, ZAR6, WL1+, WN1, WST1,
SR1+, FED1,+, FED2+, FED3+) 4.900,-

HEXAGON Spur Gear Package (ZAR1+ and ZAR5) 1,585.-
HEXAGON Planetary Gear Package (ZAR1+, ZAR5, ZAR7, ZAR8, GR1) 3,600.-

  HEXAGON Involute Spline Package (WN2+, WN4, WN5, WN10, WNXE)     1,200.-
HEXAGON Graphic Package (DXF-Manager, HPGL-Manager, DXFPLOT) 741.-
HEXAGON Helical Spring Package (FED1+, FED2+, FED3+, FED5, FED6, FED7) 2,550.-

HEXAGON Tolerance Package (TOL1, TOL1CON, TOL2, TOLPASS) 945.-
HEXAGON Complete Package (All Programs of Engineering Package, Graphics Package, Tolerance

Package, Helical Spring Package, Planetary Gear Package, TR1, FED8, FED9, FED10, ZAR4,
GEO4, WN4, WN5, FED11,WN10, ZAR1W, FED14, WNXK, FED16)

12,900.-

Quantity Discount for Individual Licenses
Licenses 2 3 4 5 6 7 8 9 >9
Discount % 25% 27.5% 30% 32.5% 35% 37.5% 40% 42.5% 45%

Network Floating License
Licenses 1 2 3 4 5 6 7..8 9..11 >11
Discount/Add.cost -50% -20% 0% 10% 15% 20% 25% 30% 35%
(Negative Discount means additional cost)

Language Version:
- German and English : all Programs
- French: FED1+, FED2+, FED3+, FED4, FED5, FED6, FED7, FED9, FED10, FED13, FED14, FED15, TOL1, TOL2.
- Italiano: FED1+, FED2+, FED3+, FED4, FED5, FED6, FED7, FED9, FED14.
- Swedish: FED1+, FED2+, FED3+, FED5, FED6, FED7.
- Portugues: FED1+
- Spanish: FED1+, FED2+, FED3+

Updates:
Update prices EUR
Software Update (software + pdf manual) 40,-
Software Update (software 64-bit Win + pdf manual) 50,-

Update Mechanical Engineering Package: 800 EUR, Update Complete Package: 1000 EUR
Maintenance contract for free updates: annual fee: 150 EUR + 40 EUR per program

Upgrades
For upgrades to network licenses or plus versions or software bundles, upgraded licenses are credited 75%.

Hexagon Software Network Licenses
Floating License in the time-sharing manner by integrated license manager
Individual licenses may not be installed in a network!

Conditions for delivery and payment
General packaging and postage costs are EUR 60, (EUR 25 inside Europe)
Delivery by Email (zip file, manual as pdf files): EUR 0.
Conditions of payment: bank transfer in advance with 2% discount, or by credit card (Master, Visa) net.

Key Code
After installation, software has to be released by key code. Key codes will be sent after receipt of payment.

HEXAGON Industriesoftware GmbH
Stiegelstrasse 8      D-73230 Kirchheim          Tel.+49 702159578     Fax +49 7021 59986
Kieler Strasse 1A      D-10115 Berlin                   Mühlstr. 13      D-73272 Neidlingen
Mobile: +49 163 7342509       E-Mail:  info@hexagon.de           Web: http://www.hexagon.de

http://www.hexagon.de

